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Logging In

1. (LOGIN) Go to www.sru.edu/IGX and the below page will appear on your screen. Your ‘User Name’ and ‘Password’ will be the same as your SRUNET
login. Click ‘Login’.

Example:
User: first.last (do not include “@sru.edu”)

Password: Your e-mail password

Note: You must use the newest iteration of Firefox, Chrome, or Safari (Mac only).

Ingeniux CMS Login

websupport

Remember me



http://www.sru.edu/IGX

Site Folder Navigation

1. (DASHBOARD) Once you login, you will see this dashboard below. Your navigation process will be done under the ‘Site’ tab on the top of the screen.

SlipperyRock Ingeniux Hosted Dev Dashboard Assets Administration Q O srufloatert ¥

SlipperyRock Ingeniux Hosted Dev Dashboard 82119 12115 PM

8/2/19 9:07 AM ‘ll IN PROGRESS

i

WHO'S ONLINE

Create New © Assignments (>} Assets © Favorites e

12 1 16,351 0 S

ACTIVITY STREAM

Monthly Production Pub Target perion

srufloater2 checked in a
page:

7/30/2019, 5:37:22 AM

srufloater2 checked out a
page:

73072019, 5:36:21 AM

Darcy White checked out a
page:

772472019, 9:39:21 AM

Click on the . icon in top left corner to open the site tree.

SlipperyRock Ingeniux Hosted Dev Dashboard

Content Store (x1)

Folder Content Properties

[@~ checkout = AssignTo~ @ _  Ppublish~
Name
[} Site Folder
(i Internal Components
(im] Orphaned Pages
(im] Recycle Folder
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2. (SITE FOLDER NAVIGATION) By clicking the triangles next to each item, the content within each subject or folder will expand.
As an example, we will be selecting a page in the site tree. Single left-click on the page that you want to edit.

NOTE: If you'll be accessing a page frequently, you can add it directly to your dashboard by entering the page number or name into the “Favorites”
section of the dashboard.

Site Tree
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International Admissions
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[ Personal Enrichment
» 5 Tuition and Fees

g » [5 Financial Aid




Checking Out, Checking In, and Publishing

Check Out

1. The user can navigate the site tree to find the page that needs to be checked out. Clicking on the page will select it and load its information/content.

Dashboard

SlipperyRock Ingeniux Hosted Production

Site Tree

G m o

» [5 First-Year Students
» [5 Graduate Admissions
» [2 Transfer Admissions
[ Readmission
» [5 International Admissions
w [3 Other Admissions
» [©) Post-Baccalaureate Students
» [% Visiting Student Admission
» [ High School Students
[ Personal Enrichment
» [5 Tuition and Fees
w » [5 Financial Aid
» [ Request Information

» [5 Visit the Rock
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Assets Administration

Personal Enrichment (x1321)

Edit Preview Categorize History XML Properties Analytics
By~ CheckoOut & AssignTo v @ . wo [J Pubish ~
Content Store ¢+ Site Folder * Home I Admissions ¢ Other Admissions ¢ Personal Enrichment
Edit Mode | = Index | [Z] Form | [Sa] In-Context I Show Index
Title
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Ed

Personal Enrichment students are those who wish to take courses without earning credit toward a degree.



2. If the page is not checked out, the user can check out the selected page by clicking the button labeled “Check Out” in the toolbar.

Cyber Security Fair (x29343)

Edit ‘ FPreview Categorize History HAML Prop

[&~ | check out o AssignTov @, mo gl

Form View ||:| 5|:||

Title [Required]

Make Changes
=

The user can then make any necessary changes to the page. Once any changes have been made, the user must save the page by clicking

Cyber Security Fair (x29343)

Edit ‘ Preview Design Categorize History XML Props

[3- checkin | B | =& Rename *% AssignTov @, wmo L

Form View ||:| 5|;||

Title [Required]




Check In

1. Once any changes have been saved, the user must check in the page by clicking on the button labeled “Check In” on the toolbar.
Note: The Check In button is located in the same position as the Check Out button was.

Cyber Security Fair (x29343)

Edit ‘ FPreview Design Categorize History AML FProp

(&~ | checkin %’ Rename *3% AssignTor @, mo L

Form View ||:|

Title [Required]



Publish

1. To publish the page and have it displayed on SRU’s website, the user can right-click on the page in the site tree.
In the right-click menu displayed, click on the option labeled “Publish.”

2.

SlipperyRock Ingeniux Hosted Prod

New

Site Tree Refresh
o Cut
A
= © —
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3. The user will see a pop up related to publishing a page. The user should select “Production” from this list.
4. The user should then click on “Incremental” to move to the next step of publishing.

Publish:
Select one or more targets to publish:
Filter Y
Publishing Target Last Publish Date
Production TM8M9 410 PM
« | i | »
»/ Perform Replication




5. The dialog may inform the user that there are no changes to the page. This usually happens when the page is already published. The user can click on the
“Proceed Anyway” button to continue, or the user can click on the “Cancel” button to review the page.

MNo Content changed since last publish »®

There are no pages and assets changed
since last publish. Do you want to cancel the
publish, or proceed anyway?

Procesd Anyvay

6. Click on “Close” to complete the publishing process.

Publish Submitted

The publish request was successfully
submitted. Do you want to monitor the
publish?

Close Monitor Publishes




Editing and Formatting Content

The Editor

The editor allows users to adjust content on their pages. Using the editor, users are able to:

e copy and paste content from another source into the editor
e bold and italicize words/phrases
e make a paragraph/sentence into a header, or a header into paragraph text

e insert links to pages within www.sru.edu, pages outside of www.sru.edu, documents, and emails
e insert lists of items using either ordered numbers or bullet points

The easiest view to use for the editor is the ‘Form’ view. In the ‘Edit Mode’ ribbon select the ‘Form’ option.

Edit Mode | == Index | [

Copying and Pasting

When inserting content into the editor, the user can user Ctrl+V to paste text prepared elsewhere into the editor. As with all Web editors, it is generally best to
work within the editor most of the time, and only copy/paste into the editor when your material has already been prepared elsewhere.

Smart Paste

Smart Paste will attempt to keep any formatting the user has made in other programs. (Example: a link in Microsoft Word inserted using Smart Paste will
automatically fill out as many details as the source text can provide.) Smart Paste is the default setting.

Content [Required] 2 ®
Edit~ Insert v View ~ Format ~ Table =
L] Fomas~ B 1 & E E =E E E = &

# Smart Phones, Stupid People: How to secure smart phones so as not to unintentionally pass
along personal data - for iPhones and Android;

« Social Media: Learn the perils of using social media and how to protect personal information
on social networking sites;

* P@ssword: Viruses, malware and how to protect against them;

» Safe Browsing: How to surf the web safely

+ Do You Use Protection?: How and why to encrypt your data

« Using Public PCs and Wi-Fi Hotspots: How to keep personal information safe when using a
publically available PC and/or Wi-Fi hotspot.

* Securing Your Home Wifi: How to ensure no one is using your Wifi router

» Viruses and Malware: Keep ransomware out

m

The Cyber Security Fair flyer is available here |

Fowered by TingHCE | =
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http://www.sru.edu/
http://www.sru.edu/

Plain Text Paste

Plain text pasting will accept any text from any source and insert it into the editor. The only sort of formatting retained is line breaking and spacing. To switch to
plain text paste, the user must click on “Paste as text” under the Edit tab. The user must toggle it off again to switch back to Smart Paste.

Content [Required]

Edit=  Insert~ View= Format~

& Undo -
ale
)h[
ils

3 Cut
re
[h copy e+
I Paste ov
Hi
v Paste as text Ir
Ho
Select all b
va

Find and replace

Bold/Italics

When inserting content into the editor, the user might want to add emphasis to a word or phrase. The user can select a word or phrase within the editor; once
highlighted, the user can click on the “B” button to make it bold or the “I” button to make it italicized.

Note: Do not overuse bold, italicized, or fully capitalized text, as long stylized passages are harder to read.

Content @

Edit Insert View Format Table Tools

I
i
th
11
i
|
Inil
b |
S
B
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Headers and Paragraphs

Sometimes, you will need to add a header to a section of your content within the editor. This dropdown box is typically labeled ‘Paragraph’ with a ‘Headings’
option that will open a secondary dropdown with various heading options.

Content

Edit Insert View Format Table Tools

W4T

S ¢ Paragraph v B I & = = =

_— 1
f— s E
- H

e > HEADING 1
Blocks ? HEADING 2

Inline > HEADING 3
diff_addition_color Heading 4
diff_removal_color Heading 5

diff_addition Heading 6

diffremoval

diff_sectionAddition
diff_sectionRemoval
mark.___igx_search_marking__
leftside_image

rightside_image

Large Header
Users can make a large header (h2) by clicking anywhere within the body of a paragraph and expanding the dropdown box to select ‘h2.’

THIS IS AN EXAMPLE HEADER

Student Center and AVI sponsor a free breakfast to students whe are commuting frem their permanent address.

Medium Header

Users can make a medium header (h3) by clicking anywhere within the body of a paragraph and expanding the dropdown to select ‘h3.’
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THIS IS AN EXAMPLE HEADER

Student Center and AVI sponsor a free breakfast to students who are commuting frem their permanent address.

Small Header

Users can make a small header (h4) by clicking anywhere within the body of a paragraph and expanding the dropdown box to ‘h4.’

THIS IS AN EXAMPLE HEADER

Student Center and AVI sponsor a free breakfast to students wheo are commuting from their permanent address.

Paragraphs
Users can make a header back into a paragraph by clicking anywhere within the header and expanding the dropdown box to select ‘Paragraph.’

Content

Edit Insert View Format Table Tools

(') c Heading 2 W B I & = = =

i
iii
&

Headings >
Blocks > Paragraph
Inline > Preformatted

diff_addition_color
diff_removal_color
diff_addition

diftremoval
diff_sectionAddition
diff_sectionRemoval
mark.__igx_search_marking
lefteide_image

rightside_image
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Creating Lists

Ordered Lists

If the user has items that need to be numbered on the page, they should enter each item and hit ‘ENTER’ before adding the next. This way, each item has its own
line. When all of the items are entered, highlight them all and click on the numbered list button.

Content [Required]

Edit~ Insert~ View~ Format~ Table~

) Formats~ B T & =

i
il
-

i
Ll
|
-~
i

= = = &
This is an example list:

L.
2.
3.

Unordered Lists

If the user has items that need to be in a list on the page but don’t need to be numbered, they should enter each item and hit ‘/ENTER’ before adding the next.
This way, each item has its own line. When all of the items are entered, highlight them all and click on the bulleted list button.
Content [Required]

Edit~ Insert~ View~ Format~ Table~

4 Formats~ B [T S =

= = = &

This is an example list:

JExample item 1

Removing Lists

To get rid of a list on a page, select all the items in the list and click on the highlighted list button (this will be the ordered or unordered list button, depending on
the type of list items selected).
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Hyperlinks

1. If the user wants to create a link, they can select the word/words that they’d like to be a link and click the “Insert/edit link” button that looks like chain
links under the ‘Insert’ dropdown box.

Content

Edit  Insert View Format Tabls

4 | [] Media.. I

Image...

I & Insert/Edit link CtrI+KI

I Anchor...

s

@ Date/time

a. Another way to create a link is to select the word/words the user would like to be a link and right click it. This will display a menu where the user
can click “Insert/edit link.”

2. The user will be prompted for the type of link (internal, external, document, anchor, or email), destination, behavior, a short/minimal title, and the class
(internal, external, or anchor).

Internal Link
If the user wants to create a link to a page that begins with www.sru.edu, they can select the word, phrase, or sentence that should be a link and click the
“Insert/edit link” button as seen above in step 1.

Insert/Edit Link x

Link To

() External () Asset () Anchor ) E-Mmail

15

1. Link To (Type): Select Internal




2. Page: There are two options when selecting an internal link page destination.
a. Type the name of the page being linked to and select it from the list of pages with that title, or
b. Type ‘X’ followed by the ID (#) of the page being linked to

Insert/Edit Link b 4

Link To

@ internal () External () Asset () Anchor () E-Mail
Link Properties
Title
Target Open in this window/frame ]
Class ‘ Not Set v|

16



3. Target: Select Open in this window/frame

Insert/Edit Link x

Link To

@ Internal () External () Asset () Anchor () E-Mail

Link Properties

Page Home (x6) Q

Title

Target | Open in this window/frame E||
Class Not Set - |

4. Title: A short/minimal description/title for the page that is being linked to

Insert/Edit Link b4

Link To
@ Internal () External () Asset (O Anchor (O E-Mail
Link Properties
Page Home (x6) Q
Title SRU Home Page
Target Open in this window/frame ]
Class Internal Link v
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5. Class: Select Internal

Insert/Edit Link b4

Link To
@ internal () External () Asset () Anchor () E-Mail
Link Properties
Page Home (xE) Q
Title SRU Home Page
Target Open in this window/frame ]
Class ‘ Internal Link

6. When the user is finished editing the link information, they can click Insert to create the hyperlink.

18



External Link
If the user wants to create a link to a page that does not begin with www.sru.edu, they can select the word, phrase, or sentence that should be a link and click
the “Insert/edit link” button.

Link To: Select External

URL: Copy and paste the destination URL (example: https://www.google.com/)
Target: Select Open in new window (_blank)

Title: A short/minimal description/title for the page that is being linked to
Class: Select External

Insert/Edit Link b4

Link To

vk wNe

() Internal @ External () Asset () Anchor () E-Mail

Link Properties
External wWww.sru.edu
Title SRU Home Page
Target Cpen in new window/frame M
Class External Link ]

Ccarcer J e
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Document Link

If the user wants to create a link to a PDF file, a Word document, etc., they can select the word, phrase, or sentence that should be a link and click the
“Insert/edit link” button.

1. Link To: Select Document
2. Document: The user can click on the square button to the right of this text box to open the Asset Browser. The user can find their document in the Asset
Browser by clicking the triangle beside a folder to expand/collapse until they find the folder that contains the document. Clicking on a Folder Name will
show its contents in the right panel. Find the document in this list, select it, and click ‘Select.’

Choose File »

t Item Q, I}ﬂ - Checkout | & & @ H| sie No Target Filter = Filter for assets Q O

v & Assets N

Search for As

» [ covid19
w [ documents
» [ about

w [ academics

w [ academic-services archived-catalogs 2023 Employer survey dat... 500_Level_Permission.pdf Academic Restart Reques..
Folder Document Document Document

¥ [[] academic-recor

[ Student-Succes
[7) students-with-d
b [ colleges
» [0 departments

[7J honors-program

X AcademicStandards Ddf ACtdBCreditHOUrReqUeSlF.. Address & Phone Number... Amicwpated_graduatiOn_\e...
» O international-exper Document Document Document Document

[ library

[0 online-leaming

» [ research

™1 wsim bmr s o
1 3

3. Target: If the document is a PDF, the user should select Open in new window (_blank). Otherwise, the user should select Open in this window/frame.
4. Title: A short/minimal description/title for the page that is being linked to
5. Class: Select External
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Email Link
If the user wants to create a link to someone’s email, they can select the text that should be a link and click the “Insert/edit link” button.

Link To: Select Email
E-Mail: Enter the email address of the desired recipient

Target: Select Open in new window (_blank)
Title: Type ‘Email’ followed by the recipient’s name

Class: Select External
Insert/Edit Link b 4

vk wnN e

Link To
() Internal () External () Asset (O Anchor O E-mail
Link Properties
E-Mail websupport@sru.edu
Title Email websupport
Target Open in new window/frame "|
Class External Link ]
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Editing Accordions

1. Some pages contain “accordion” components. For example, the Council of Trustees page’s accordion can be seen below.

For additional information on the members of the Council of Trustees, please see each member's profile in the
accordion below.
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2. To edit the accordion, open the site tree and click on the item with accordion in its title.
P[] Alumni
P [ Community
* [J Veterans
¥ [& Veterans and Military-Related Admissions
£+ Veterans and Military-Related Admissions Accordion

£l support Organizations

[£l Returning or Leaving Active Duty
& veteran's Center

P & Give to SRU

P & News

3. Before the user can edit the accordion’s content, the user must click the ‘Check Out’ button shown in the picture below.

Veterans and Military-Related Admissions Accordion (x1459)

Edit Categorize History XML Properties Analytics

[&~ | checkout =  AssignTo~ @ . mo Publish~
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4. Open the tab the user wants to edit by clicking on the small arrow to the right of the corresponding tab.

Edit ‘ Categorize History AML Properties Analytics

[3' Check In ﬂ Rename ”"’3 Assign To = 'ﬁf’ ~ B¢ Publish =
Formview ¥ | | O =0 |
Accordions [Required] 2 ®

List Type: Component Quantity: 4 Add New

Accordionitem @ &L
e

Component: Transfer Admissions - Accordion tab

(V)
Accordionitem @ B

Component: Graduate Admissions - Accordion tak

Accordionitem @ &
Component: Post-Bacc Admissions - Accordion tal

Accordionitem ORI *
re

Component: Mon-Degree Admissions - Accordion ©

o
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5. Once the user clicks on the drop-down arrow, the page should look like the one below. The user can edit the accordion title and content.

Accordionltem @ O
Component: Graduate Admissions - Accordion tab

@

Title [Required]

Graduate Admissions

Content [Required]

Edit+ Inset= View= Format= Table~

T
Pt

S @ Fomats~ B [ S =

Veterans and individuals currently serving in the military who have already completed a bachelors
(4-year) degree from an accredited university and wish to pursue graduate work at SRU, should

apply through Graduate Admissions.

Fowered by TingHMCE
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6. Once the user is finished editing the accordion tab’s information, the user can collapse the item with the small up arrow to the right of the
corresponding accordion item.

Accordionitem ORIK *

Component: Graduate Admissions - Accordion tab

Q
*

Title [Required]

Graduate Admissions

Content [Required] @

Edit~ Insert= View= Format> Table~w

“ ®* Ffomas B [T & E E ZE E = = E E &

Veterans and individuals currently serving in the military who have already completed a bachelors

(4-year) degree from an accredited university and wish to pursue graduate work at SRU, should
apply through Graduate Admissions.

Click here for more information. Fowered by TingHCE
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7. To edit the number of accordion tabs, the user can click on the ‘Settings’ gear icon.

Accordionitem [] @ Q

Component: Graduate - Accordion Tab m

8. Then, to add an accordion tab, the user can click on the ‘Plus’ icon. This duplicates the selected accordion which can now be edited with the intended
copy.

Accordionitem [] 1=

Component: Graduate - Accordion Tab

®
s
& )

9. To delete an accordion tab the user can click on the ‘Minus’ icon.

Accordionitem [] 1=

Component: Graduate - Accordion Tab

EE
®

€3
@

10. The user can also change the order of the accordion tabs by clicking and dragging the left-hand portion of the accordion tab.

Accordionitem [] @ Q @3

Component: Graduate - Accordion Tab Unembed m
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11. Once all of the editing is complete and the box being edited is collapsed, the user must ‘Save’ the accordion item.

Veterans and Military-Related Admissions Accordion (x1459)

Edit Categorize History XML Properties Analytics

[~ Chechlnﬂ Rename "% AssignTov @, =< Publsh~

12. Once all of the editing is saved, the user must check the accordion back in by selecting the ‘Check In’ button shown below.

Veterans and Military-Related Admissions Accordion (x1459)

Edit Categorize History XML Properties Analytics

(&~ | checkin = Rename *3% AssignTov @, wo Puplish~
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13. In order to implement these edits, the user must publish the accordion. To do so, right-click on the accordion that was edited and select ‘Publish’.

I T
MNew 3
Rename o o
Refresh
Cut

) Copy &

wck Ingeniux Hosted De T
Pasie

ilder
Delete

12
Add to Workdflow

WJAX Assign To.. »

cademics Show History

ife at SRU Send Mail

bout Check Qut

tudents Check In

aculty and Staff Undo Check Out =
Rollback

amily

. Mark/Unmark for Publish

Jumni
Preview

‘ommunity .
Publish

eterans
Page Properties

Veterans and Milit:
] Paste without children
£ Veterans and Muntary-rRelatea Aamissions accordion
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14. Select ‘Production’ as the ‘Publishing Target’, then click ‘Incremental’.

Publish: ®

Select one or more targets to publish:

Filter Y

Publishing Target | ast Publish Date

Production B8/2M19 1:44 PM

< ] 3

Cancel Full Incremental

/ Perform Replication

15. When the ‘Publish Submitted’ box shows up on screen, the user can hit ‘Close’. This will complete the accordion editing and publishing.

Publish Submitted

The publish request was successfully
submitted. Do you want to monitor the
publish?

Monitor Publishes
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Logging Out

1. Once all of your work is completed within Ingeniux, you should sign out of your session by clicking the ‘Sign Out’ button.

Q . srufloater2 2

&  Edit your Profile
A Change Language »

Q. Change Password
(V] Sign Out

Q, Show Path

This page must be checked out to you you can edit it!
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